
Guidelines for Computer Outage Downtime 

 
The following guidelines are provided to Patents supervisors and examiners in the event of 

computer problems or outages. Supervisors should look at each individual examiner’s 

circumstances related to the computer problem or outage before granting or denying other time. It 

is noted that Docket Management (DM) is outside of the purview of this document. 

 
GENERAL 

In the event that the Office experiences an outage of an examiner’s work station, individual 

automated tools (e.g. PE2E DAV, IFW, EAST/WEST, etc.), or a full-scale USPTO system outage, 

examiners should work on other activities not affected by the outage (see Computer Downtime 
Guidance on Automation Alternatives), and if no other work is available the supervisor should assign 

duties that do not require using tools affected by the outage.  Requests for non-production time 

will normally not be granted for service disruptions of short duration of power at the alternate 
work site or with the employee’s Internet Service Provider (ISP). Supervisors should remind 

examiners in their art units that they must consult with a supervisor or designee prior to claiming 

other time for computer problems or outages, when practicable.  In order to be granted other time 

for computer problems or outages, an examiner must consult with a supervisor prior to claiming 

other time via WebTA, where practicable.  As appropriate, the supervisor will grant reasonable 

other time to the examiner in a timely manner.   

 

These guidelines and procedures apply to all patent examiners, regardless of duty station.  It is the 
expectation that by following the universal procedures, as detailed below, and in the Computer 

Downtime Guidance on Automation Alternatives document, all reasonable other time requests will be 
granted by the supervisor. If the examiner feels that reasonable other time has not been granted 

by the supervisor, the examiner may contact the TC Director. Requests for and approval of other 

time in these situations should occur as early as possible in the pay period so that the employee’s 

WebTA can be validated and certified timely.    Furthermore, these guidelines supersede PHP 

guidelines (Patent Hoteling Program, 07/08/05) with regard to computer downtime (i.e. non-

examining or other time). 

 
The procedure applies to all USPTO outage scenarios, individual or a full-scale system outage, as 
outlined in the Computer Downtime Guidance on Automation Alternatives.  The examiner should follow 
the steps below in order to receive other time:   

  
1. Contact the OCIO Service Desk - Examiners experiencing computer related issues (IT issues), 

should follow the steps of contacting the Service Desk, via phone at 2-9000 or e-mail 

servicedesk@uspto.gov or S9000 form, report the problem and obtain a ticket number.  If the 

examiner is unable to obtain a ticket number proceed to step 2. 

2. Consult the supervisor or designee of the IT issue in a timely manner of current steps taken to 

work around the outage (see Computer Downtime Guidance on Automation Alternatives for 

Patent Examiners).  Supervisors can provide information to employees on available alternative 

work that can be performed. If the supervisor or designee is not available, the examiner leaves 

a voicemail or e-mail message to the supervisor stating the IT issue that they are experiencing 

and current steps being taken to work around the issue, in a timely manner.   

3. Communicate to the supervisor the duration of the IT issue and work with supervisor to 

determine appropriate other time to be granted.  The supervisor will work in a timely manner 

to grant and notify the examiner of other time granted as appropriate.   

4. Record in Remarks section of WebTA the outage experienced along with the ticket number 

provided by the Service Desk (e.g. INC000001536827 - Hard Drive Crash – 2 hours). 

 

In the instance of a full-scale USPTO system outage, follow guidance issued by Patents Management. 

mailto:helpdesk@uspto.gov
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POST-OUTAGE 
 

Requests for other time should be handled on a case-by-case basis in view of the specific facts 

of the individual situation. The following are examples of factors that a supervisor will consider 

in determining if other time is appropriate: 

 
• Did the examiner contact the Service desk and was a ticket/reference number generated? 

(In order to assess severity of the problem and/or time spent). 

• What applications or systems were not available? 

• How long were the applications or systems down? 

• Did the examiner lose any work that had to be recreated? Has the examiner provided 

serial numbers and a description of the work that had to be recreated, to allow the 

supervisor to determine if the amount of time claimed is reasonable?  Note that time to 

create work is only appropriately granted AFTER the IT issue is resolved and the 
examiner is able to utilize the tools needed to recreate lost work. 

• Did the examiner have other work to do (i.e. IFW Backup tool, classification, PCTs, 

attend or complete online training, rearrange work to use a tool that is currently 

operational, etc.) during the outage? 

• Did the examiner inform his/her supervisor of the computer outage in a timely 

manner, in order that the supervisor could assign other work if available? 

• Did the supervisor temporarily assign another computer workstation? 
• Was the examiner able to work as usual, but experiencing slowness that impacted 

efficiency? 
 

For more guidance or questions on computer problems or outages, consult with your Supervisor 

or designee. 

 
Please send questions and feedback regarding the Computer Outage Downtime Policy or 

this Guidance to Computer Downtime Feedback Form. This is to be used for questions 
regarding the policy and NOT to be used for requesting IT support or other time. This 

mailbox will be available until January 1, 2019. 

 
Types of Outages Examples Web TA PPA Code 

Time to recreate lost work 
(Catastrophic  Failure) 

Recreating office actions, 
searches, etc. due to computer 
system failures – NOT FOR USE 
DURING OUTAGES. 

PNCSPA-0000-090180 

Computer System Outage Failure of USPTO provided 
equipment, computer system, or 
USPTO computer application. 

ANTIME-0000-A00131 

Power Outage Power is interrupted or fails 
Campus-wide, building- wide, or 
building floor. 

ANTIME-0000-A00131 

https://usptogov.sharepoint.com/sites/e94feec1/Lists/Feedback/NewForm.aspx


COMPUTER DOWNTIME GUIDANCE ON AUTOMATION ALTERNATIVES 

This guidance is provided to supplement the “Guidelines for Computer Outage Downtime.” The 

procedures explained below apply to all USPTO outage scenarios (e.g. individual USPTO system 

or USPTO equipment or full-scale USPTO). In the event of a full-scale USPTO system outage, 

also follow any guidance issued by Patents Management. These procedures should be followed 

in order for an examiner’s request to be considered and approved for other time or 

administrative leave. Information on all available tools can be found on the Patents home 

page. 

Examiners experiencing computer related issues should contact the OCIO Service Desk, via 

phone at 2-9000 or e-mail servicedesk@uspto.gov or S9000 form, to report the problem and 

obtain a ticket number in addition to contacting their supervisors.  In order to be granted 

other time for computer problems or outages and if time permits, an examiner must consult 

his/her supervisor or designee prior to claiming other time via WebTA, when practicable.  It is 

noted that Docket Management (DM) is outside of the purview of this document. 

Examiners can both take preventative actions to minimize the impact and find alternative ways 

to accomplish their tasks in the event of a system outage.  The examiner must alert the 

supervisor or designee of the problem in a timely manner.  The supervisor or designee, if 

needed, will assist in steps to work around the outage.  Once all reasonable steps are 

exhausted the examiner should further communicate to the supervisor the duration of the 

outage, the steps taken to work around the outage, and then work with the supervisor to 

determine appropriate other time to be granted. The supervisor will work in a timely manner 

to grant and notify the examiner of the amount of other time granted as appropriate.  Some 

examples of preventive measures and steps to take in working around the outage include, but 

are not limited to: 

Prevention 

1.  Log off or restart your computer workstation periodically (OCIO recommends at a 
minimum weekly). 

2.  Clear Google Chrome browser cache. 

a. On your browser toolbar, click More located top right of toolbar 
- More Tools - Clear Browsing Data. 

b. In the "Clear browsing data" box, click the checkboxes for 
Cookies and other site data and Cached images and files. 

c. Use the menu at the top to select the amount of 
data that you want to delete. Choose beginning of 
time to delete everything. Note: This option does 
not appear on all devices. 

d. Click Clear browsing data 

3.  Save a PDF of the applications on your docket (PALM report DM 3105) to your 
local computer. 

4.  Save a PDF of the application(s) or parts of applications you are 

working on to your local computer.  PE2E-DAV Create PDF Files QRG 

http://ptoweb.uspto.gov/patents/
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5.  Enable the AutoSave feature in Microsoft Word and set the time setting to a 

shorter duration. With OACS or OC open on your desktop, click the File tab > 

Options > Save, then place a check in the box labeled Save Auto Recover 

information every XX Minutes. 

a. Access OC Blank Correspondence (BC) ‘checkpoints.’ In 

addition to the OC working copy, whenever the BC 

document is saved and Closed, a ‘checkpoint’ version is 

created in a separate directory 

(Documents/OC/Checkpoints). Unlike the working copies, 

these Checkpoint files do not get overwritten by 

subsequent updates.  A new one (with a different 

timestamp) is created whenever the document is saved 

and closed, and will remain as ‘backup’ copies of action’s 

contents. 

6.  Enable the AutoSave feature in EAST and set the time setting to a shorter 

duration. With EAST open on your desktop, select Tools > Options > Files, 

then place a check in the box labeled AutoSave every XX Minutes. 

7.  Avoid concurrently running more applications than you need to be 

efficient and save work regularly.  It is recommended to close applications 

that are not currently in use. 
 

Response (Steps to work around the outage)  

1. For all scenarios examiners can perform duties, if assigned and/or 
authorized, such as classification, transfer inquiries, interviews, pre-
authorized, or supervisor approved training, review office actions of 
examiners they may be training, provide assistance to other examiners, or 
set up and participate in appeals conference. 

a. Complete pre-authorized or supervisor approved on-line 
training at Commerce Learning Center. 

2. When software systems (OACS/OC, EAST/WEST, DAV) are down try using 

other systems that may be operational (i.e. OACS/OC is down use 

EAST/WEST to search an application or use Microsoft Word to compose 

office actions).  If the Internet is an appropriate search tool for your 

application, then search the Internet, including the resources outlined on 

the USPTO’s external searching site.  Examiners should be aware of the 

restrictions regarding the sp e c i f i c i t y  of searches on the Internet for 

unpublished applications.  See MPEP section 904.02(c) for the policy 

regarding using the Internet to perform prior art searches. 

3.  Further alternative tools that you may be able to use include but are not limited 
to: 

a. Search 

https://doc.csod.com/client/doc/default.aspx
http://www.uspto.gov/patents/process/search/index.jsp
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i. USPTO Patent Full-Text and Image Database (PatFT) 

ii. USPTO Patent Application Full-Text and Image 
Database (AppFT) 

iii. Common Citation Document (CCD) 

iv. International Patent Office databases 

v. European Patent Office (EPO) esp@cenet 

vi. World Intellectual Property Organization (WIPO) 
PATENTSCOPE 

vii. Published Sequences at the Publication Site for Issued 
and Published Sequences (PSIPS) 

viii. Patent Assignment Search 

ix. Internet based services for searching patent data also 
exist, such as: Google Patents (patents.google.com) 
and IP.Com   (https://iq.ip.com/discover) 

b. Viewing Examiner Docket 

i. Docket Application Viewer (DAV) 

ii. PALM Docket View 

iii. Docket Manager Planner 

iv. Examiner Dashboard 

v. PALM 3105 Docket Report 

c. Viewing Applications 

i. Docket Application Viewer (DAV) 

ii. Image File Wrapper (IFW) 

iii. File Inspection Utility 

iv. Public PAIR 

v. IFW Backup 

d. Writing Office Actions  

i. OACS/OC 

ii. Word 

iii. Notepad 

4.  When there is a VPN or remote access outages: 

a. Retry the Smartcard/PIV/Security Badge.   If unable to 
access please refer to HSPD enforcement Scenarios. 

b. Verify personal Internet access via your own Internet 
Service Provider connection. 
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c. If you are still unable to connect to system use Public PAIR 
(if you have Internet access) or working folders (official or 
self-generated) to read and prepare applications for 
examination.    

5.  When there is a USPTO Outage/On Campus USPTO Network 
Connectivity/Individual ISP outage, examiners can use working folders 
(official or self-generated) to read and/or prepare applications for 
examination. If the Universal Laptop is operational, but experiencing 
connectivity issues, Microsoft Word can be used to start drafting portions 
of an Office Action as appropriate.  

6.  When there is a laptop replacement for a TEAPP employee, that does not 
include agency wide replacement of laptop or equipment: 

1. The employee may request: 

a. Catastrophic time for lost work and  

b. Other Time for replacement event up to 4 hours unless 
delivery is delayed based on circumstances outside of the 
examiner’s control. 

2. Management would expect, if practicable: 

a. Employee to flex a reasonable amount of time to minimize 
other time. 

b. Employee to work on tasks not requiring a USPTO laptop 
(e.g. Take training from Learning Center, watch technology 
specific videos or read technical literature). 

c. Continue to keep supervisor apprised of the situation. 

 

 


